
IMD Plus 
User Manual



Version 15



IMDPlus User Manual 
 LUSAS Version 24.0 : Issue 1 



 

LUSAS 
Forge House, 66 High Street, Kingston upon Thames, 

Surrey, KT1 1HN, United Kingdom 
 

Tel: +44 (0)20 8541 1999 
Fax +44 (0)20 8549 9399 
Email: info@lusas.com 
http://www.lusas.com 

 
Distributors Worldwide 

 
Copyright ©1982-2026 LUSAS  

All Rights Reserved. 
 



Table of Contents 

i 

Table of Contents 
IMDPlus Assumptions ............................................................................................................... 2 
Performing IMDPlus Calculations in LUSAS .......................................................................... 3 
Seismic Analysis ............................................................................................................................................ 3 
Moving Load Analysis ................................................................................................................................... 3 
Moving Mass Analysis .................................................................................................................................. 3 
IMDPlus Toolbar ......................................................................................................................... 4 
Seismic Analysis ........................................................................................................................ 6 
Earthquake Input ............................................................................................................................................ 7 
Mode / Damping Control ............................................................................................................................... 8 
Frequency Interpolation ................................................................................................................................. 9 
Moving Load Analysis ............................................................................................................. 11 
Moving Load Generation ............................................................................................................................. 12 
Modal Force Calculator ............................................................................................................................... 18 
Running the Moving Load Analysis ........................................................................................................... 19 
Moving Mass Analysis............................................................................................................. 23 
Spring-Mass System Properties................................................................................................................... 25 
Moving Mass Vehicle Configuration.......................................................................................................... 30 
Moving Load Generation ............................................................................................................................. 31 
Modal Force Calculator ............................................................................................................................... 35 
Running the Moving Mass Analysis ........................................................................................................... 36 
Visualising the Results............................................................................................................ 44 
Node / Element Selection ............................................................................................................................ 47 
Spring-Mass System Selection (Moving Mass Only) ................................................................................ 49 
Output Control .............................................................................................................................................. 51 
Elements Supported By IMDPlus ........................................................................................... 58 
Worked examples ..................................................................................................................... 59 

 

 
 

 



IMDPlus User Manual 

ii 

 

 



 

1 

IMDPlus User 
Manual 
The IMDPlus modal dynamics software option calculates the modal response of a 
system to a given input using calculated eigenmodes and eigenvectors from an 
eigenvalue analysis. (Note that the eigenvalue analysis must have been performed with 
mass normalised eigenmodes.) 

There are three types of analysis that can be performed in IMDPlus. These are as 
follows: 

 Seismic Analysis 
A seismic analysis obtains the dynamic response of a structure to acceleration 
time histories of support motion. 

 Moving Load Analysis 
A moving load analysis obtains the dynamic response of a structure to moving 
loads. In a moving load analysis the load can either be explicitly defined or a 
vehicle configuration (composite axle definition) can be used. In both cases the 
magnitude and configuration of the load remains constant throughout the 
analysis. 

 Moving Mass Analysis 
A moving mass analysis obtains the dynamic response of a structure to moving 
masses. In a moving mass analysis spring-mass systems are used in a vehicle 
configuration. Each spring-mass system includes an unsprung mass and up to 
two sprung masses connected by springs and viscous dashpots. The 
configuration of the systems remains constant throughout the analysis but as 
they move across the structure, the dynamic response of the unsprung and 
sprung masses affects the forces acting on the underlying structure due to inertia 
effects. 

 
All solutions from IMDPlus are carried out in the time domain. 
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IMDPlus Assumptions 
The working assumptions for the IMDPlus modal dynamics facility are as follows: 

 Linear 
The system is linear in terms of geometry, material properties and boundary 
conditions. Therefore geometrically nonlinear eigenvalue results are not 
applicable. Nor are nonlinear joint and slideline analyses suitable for this type of 
post-processing treatment. 

 No Cross-Coupling 
There is no cross-coupling of modes caused by the damping matrix. This is 
reasonable for all but the most highly damped structures or applications. 

 Low Modes Dominant  
The response is dominated by the lowest few modes. 

 Damping Ratios Are Below Critical  
Damping ratios of 100% or more are not permitted due to the solution of the 
time domain response of the structure using either the Hilber–Hughes-Taylor 
(HHT) method or Duhamel’s Integral. 

 Moving Mass Analysis 
The working assumptions for the particular case of a moving mass analysis are 
as follows: 

 No Loss of Contact 
There is no loss of contact between the unsprung masses (wheels) of the spring–
mass systems and the structure at any time during a moving mass analysis. 

 Vertical Motion of Spring-Mass Systems Only 
Only vertical motion of the spring-mass systems is considered in a moving mass 
analysis. 

 Mass of Spring-Mass Systems Not Included in Eigenvalue Solution 
The mass of the spring-mass systems have no effect on the natural frequencies 
of the structure. 

 Recommended Limit on Total Mass of Spring-Mass Systems 
The accuracy of the moving mass solution reduces for light-weight structures or 
structures where the magnitude of the moving mass is similar to the magnitude 
of the structure mass. A literature search recommends that for most solutions of 
this type, the total mass of all the spring-mass systems that are actively 
interacting with the structure at any given time should not exceed 10% of the 
total mass of the underlying structure. 
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Performing IMDPlus Calculations in LUSAS 
The various stages of an IMDPlus analysis are initiated from the Analyses > IMDPlus 
menu or the IMDPlus Toolbar. The basic steps that need to be undertaken for each of 
the three analysis types are as follows: 

Seismic Analysis 
1. Select the acceleration time histories 
2. Select the eigenmodes to include in the solution 
3. Specify the damping for the eigenmodes 
4. If required, modify the advanced solution options 
5. Specify the frequency interpolation technique and if required, the time step 
6. Specify the nodes or elements to process along with the output requirements 

Moving Load Analysis 
1. Generate the movement of a discrete load across the structure by using a 

number of distinct locations along the moving load path 
2. Calculate the equivalent modal forces for each of these distinct locations 
3. If the loading has not been explicitly defined in step 1, define moving load 

vehicle configuration(s) using the positions of the axles/bogies that form a 
vehicle together with the moving load factors to be applied at each position 

4. If required, select the moving load vehicle configuration to be used in the 
analysis 

5. Select the eigenmodes to include in the solution 
6. Specify the damping for the eigenmodes 
7. If required, modify the advanced solution options 
8. Specify the speed ranges to analyse along with time stepping parameters 
9. Specify the nodes or elements to process along with the output requirements 

Moving Mass Analysis 
1. Generate the movement of a discrete unit load across the structure by using a 

number of distinct locations along the moving load path 
2. Calculate the equivalent modal forces for each of these distinct locations 
3. Define spring-mass system property attribute(s) 
4. Define moving mass vehicle configuration(s) using the positions of the 

axles/bogies that form a vehicle together with the spring-mass system property 
attribute that is to be used at each position 

5. Select the moving mass vehicle configuration to be used in the analysis 
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6. If required, include a path surface profile that defines the surface irregularities 
along the length of the moving load path 

7. Select the eigenmodes to include in the solution 
8. Specify the damping for the eigenmodes 
9. If required, modify the advanced solution options 
10. If required, modify the path surface profile options 
11. Specify the speed ranges to analyse along with time stepping parameters 
12. Specify the nodes, elements or spring-mass systems to process and the output 

requirements 

IMDPlus Toolbar 
All of the IMDPlus dialogs can be launched from the Analyses > IMDPlus menu. 
Alternatively, the IMDPlus Toolbar can be activated from the View > Toolbars... 
menu, as shown in the following figure. 

 

The Toolbar has been split into four sections as follows: 

 Analysis Type 
This section allows the IMDPlus analysis type to be selected. Options available 
are as follows: 

 Seismic Analysis 

 Moving Load Analysis 

 Moving Mass Analysis 

Only one of the analysis types can be selected at any time. 
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 IMDPlus Vehicle Attributes 
This section allows IMDPlus attributes to be defined prior to an IMDPlus 
analysis. Options available are as follows: 

 Spring-Mass System Properties 
This button opens the spring-mass system properties dialog. It is only 
available when the analysis type is set to moving mass. 

 Vehicle Configurations 
This button opens either the moving load or moving mass vehicle 
configuration dialog. The dialog launched depends on the analysis type 
selected. The button is only available when the analysis type is set to 
moving load or moving mass. 

 Moving Load Generation and Modal Force Calculator 
This section allows the preliminary steps for a moving load or moving mass 
analysis to be performed. These are the generation of the moving load path and 
the calculation of the modal force history for use in the IMDPlus analysis, as 
follows: 

 Moving Load Generation 
This button opens the moving load generation dialog. It is only available 
when the analysis type is set to moving load or moving mass. 

 Modal Force Calculator 
This button opens the modal force calculator dialog. It is only available 
when the analysis type is set to moving load or moving mass and the 
moving load generation step has already been carried out. 

 Running an IMDPlus Analysis 
This section allows an IMDPlus analysis to be performed. Options available to 
the user are as follows. 

 Analysis Control 
This button opens either the seismic, moving load or moving mass 
analysis control dialog. The dialog launched depends upon the analysis 
type selected. For both moving load and moving mass analysis types the 
button is only available when the modal force calculation has been 
carried out. 
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 Output Control 
This button opens either the seismic, moving load or moving mass output 
control dialog. The dialog launched depends upon the analysis type 
selected. It is only available when an IMDPlus analysis has been carried 
out and results are still available on disk for graphing.  

Note. When multiple outputs (e.g. graphs) are required, IMDPlus should always be 
‘driven’ from the IMDPlus toolbar because this provides access to the Output Control 
page of the wizard directly from the toolbar without first visiting the Seismic Analysis 
Control page where you are effectively starting a new analysis. After making choices, 
clicking the Apply button on the Output Control dialog will allow multiple outputs to 
be obtained. Clicking the Finish button on the Output Control dialog will require the 
Seismic Analysis Control page to be visited prior to making any other Output Control 
settings. 

Seismic Analysis 
The seismic analysis option calculates the response of the structure to an acceleration 
time history applied at the support nodes. Both 2D and 3D structures can be analysed 
but they are restricted to having the acceleration inputs applied in the global X-, Y-
directions and X-, Y- and Z-directions respectively. Only one acceleration time history 
can be specified for each excitation direction and therefore, all support nodes are 
accelerated with the same time history record in this direction. Different acceleration 
records can be applied to each global direction and these can be factored based on 
design code requirements. Up to seven earthquake combinations can be analysed in a 
single IMDPlus analysis. 

The IMDPlus seismic analysis control dialog is accessed from the Analyses > 

IMDPlus > Seismic... menu or from the IMDPlus Toolbar. Ensure the  button is 

selected to choose a seismic analysis and then select the  button to launch the 
seismic analysis control dialog. 

 



Seismic Analysis 

7 

 

Earthquake Input 
For two-dimensional structures, earthquake acceleration time history records can be 
applied in the global X- and Y-directions. For three-dimensional structures, an 
additional earthquake acceleration component in the global Z-direction can be applied. 
Permissible input formats for these acceleration records are space delimited, TAB 
delimited or Comma Separated Variable (CSV). 

For all of these input formats, the time step of the acceleration records must be 
identical in all of the earthquake acceleration files. IMDPlus supports the solution of up 
to seven earthquakes at a time with enveloping / averaging of the Secondary Response 
Spectra (SRS). For space or TAB delimited files the number of time steps in each 
directional record for multiple record files must be identical across each of the 
earthquakes. For Comma Separated Variable files, the number of time steps in each 
directional record can vary but the number of time steps in individual earthquakes must 
be identical. If more than one earthquake is present in the record files, the IMDPlus 
analysis will process all valid combinations. 

Sample Acceleration Time History Records 
Space Delimited Single Combination Space Delimited Two Combinations 

0.000  0.0000E+000   0.000  0.0000E+000  0.0000E+000 
0.005 -2.7459E-002   0.005 -2.7459E-002 -4.0070E-005 
0.010 -3.4127E-002   0.010 -3.4127E-002  8.2210E-004 
0.015 -4.0796E-002   0.015 -4.0796E-002  1.2618E-002 
0.020 -4.7464E-002   0.020 -4.7464E-002  1.4741E-002 
0.025 -5.4133E-002   0.025 -5.4133E-002  1.8604E-002 
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Mode / Damping Control 
The modes to include in the analysis can be controlled either by the eigenmodes solved 
in the eigenvalue analysis or a subset defined in the mode control. The default option 
when first running an analysis is for all modes to be included in the analysis but 
individual modes can be included or excluded using the following dialog accessed via 
the Modify… button on the seismic analysis control dialog. 

 

This dialog also calculates the total participating mass for the included modes. If a 
significant proportion of participating mass is missing, based on the selected modes of 
vibration, a warning will be issued when proceeding with the analysis. Omission of 
modes of vibration with significant mass contributions that can be excited by the input 
acceleration time histories will lead to unreliable solutions. Ideally, total mass 
participations in excess of 90% should be used unless it is guaranteed that the modes of 
vibration associated with any missing mass are at frequencies that cannot be excited. 

The Default damping option allows the user to control the amount of damping used in 
the IMDPlus analysis. If Default damping is selected, all of the modes of vibration 
included in the analysis are forced to have the current default value. The default value 
is set, via the Modify… button on the seismic analysis control dialog. 

 

The Default damping option can only be turned off when viscous damping has been 
included in the eigenvalue analysis. If Default damping is deselected the viscous 
damping present in the eigenvalue analysis is used in the IMDPlus analysis. When 
viscous damping is included in the eigenvalue solution additional options for the 
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inclusion of overdamped modes of vibration in the IMDPlus analysis also become 
available. These options are as follows: 

 Ignore overdamped modes 
Modes of vibration with a damping ratio of 100% or more are omitted from the 
IMDPlus solution. 

 Limit overdamped modes to critically damped 
Modes of vibration with a damping ratio of 100% or more are limited to 
99.9999% to allow them to be included in the analysis. 

Frequency Interpolation 
Four interpolation options are available for the interpretation of the acceleration time 
histories in IMDPlus. These are as follows: 

 All frequencies included 
All modes of vibration are included in the analysis even if their frequencies are 
greater than the maximum frequency that may be reliably resolved based on the 
acceleration time history time step (the Nyquist frequency). 
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 Limit frequencies to Nyquist frequency 
All modes of vibration up to and including the Nyquist frequency are included 
in the analysis. Modes of vibration with frequencies in excess of this value are 
discarded. 

 Linear interpolation of records 
Allows for linear interpolation of the earthquake records. The required time step 
is specified by the user for the analysis. 

 Cubic spline interpolation of records 
Allows for cubic spline interpolation of the earthquake records. The required 
time step is specified by the user for the analysis. 

Note. For rapidly varying input acceleration time histories, such as real acceleration 
records measured on site that often have large reversals in acceleration over one or two 
time steps, the cubic spline interpolation should generally not be used. For synthetic 
acceleration time history records, the use of cubic spline interpolation is usually valid 
since the Fourier series used to generate the synthetic records tend to produce smoother 
responses. It is however up to the user to ensure that the method of interpolation used is 
suitable for the analysis being carried out. 

Note. The Nyquist frequency is equal to 1/(2*δt) where δt is the time step of the 
acceleration time history. 

Advanced Seismic Solution Options 
Advanced solution options can be set via the Modify... button on the seismic analysis 
control dialog. 

 

The options available in a seismic analysis are as follows. The Defaults button resets 
all of the options to the default values. 

 Time integration scheme for structure response 
The implicit time integration scheme used by IMDPlus to calculate the dynamic 
response of the structure. 

 Hilber Hughes Taylor (HHT) 
This is the default time integration scheme and is the same as the method 
used for an implicit transient dynamic analysis in LUSAS. 

 HHT factor α 

 

 
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The integration constant α used in the HHT integration scheme. For an 
unconditionally stable, second order accurate scheme, α must lie between 
the limits -1/3 ≤ α ≤ 0.0. Values of α outside this range cannot be 
specified. The default value of α is 0.0, which reduces the method to the 
Newmark method. Further integration constants β and γ are computed 
automatically by IMDPlus using the following equations: 

 ( ) ( )2
1 4      ,     1 2 2β = − α γ = − α  

 Duhamel’s Integral 
This is the time integration method used by IMDPlus in LUSAS 14.7 (and 
earlier versions of LUSAS) and is available as an alternative to the HHT 
integration scheme. 

Moving Load Analysis 
The moving load analysis option obtains the dynamic response of the structure to the 
passage of a moving load along a user defined path. Both 2D and 3D structures can be 
analysed and the magnitude and configuration of the load remains constant throughout 
the entire analysis. Two methods are available for the definition of the moving load 
configuration. These are: 

 Explicit definition 
The complete load configuration is defined through a discrete load definition in 
Modeller. This can be used for analysing the passage of a single load 
configuration across the structure. 

 Composite axle definition 
The complete load configuration consists of a unit load single axle 
configuration, defined as a discrete load definition in Modeller, and a vehicle 
configuration is that is defined separately. The vehicle configuration (composite 
axle definition) method is the recommended approach, as it allows multiple load 
configurations (such as multiple train rolling stock configurations) to be 
analysed rapidly without having to repeat initial steps for the IMDPlus solution. 

Irrespective of the method used, two distinct steps are required to prepare the moving 
load input data for IMDPlus. These two steps are as follows: 

1. Generation of the moving load path across the structure 
2. Calculation of equivalent modal forces for the moving load path 

 

Note. These two steps must be carried out before the first analysis but may be omitted 
from subsequent analyses, if and only if the moving load path, discrete load 
configuration and direction of the moving load do not change between analyses. If any 

 
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of these are modified the moving load path and calculation of equivalent modal forces 
must be carried out again. 

Moving Load Generation 
The moving load generator is used to mimic the passage of a load across a structure by 
automatically setting up a number of static load cases at prescribed locations along a 
single line/arc/spline, or a collection of lines/arcs/splines, which define a single 
continuous path. These load cases can then be used to calculate the modal forces 
equivalent to the applied loading for import into IMDPlus. Before entering the moving 
load generator, the lines/arcs/splines defining the path must be selected and a discrete 
load representing the load configuration that is to be moved across the structure must 
have been defined. 

The definition requirements for this discrete load are governed by the type of moving 
load input that is going to be used in IMDPlus. If the discrete load is going to represent 
the whole load configuration (i.e. a vehicle configuration is not being used) then it must 
contain all of the loading associated with the configuration. However, if the composite 
axle definition method is being used in IMDPlus, this discrete load should represent a 
subset of the overall load configuration and will be used along with the vehicle 
configuration to build up the total load configuration in IMDPlus. 

Explicit Definition of United Kingdom HB Vehicle 
For the LUSAS Bridge option, HB vehicles can be defined from the Bridge > Bridge 
Loading > United Kingdom... menu entry. 

 

After defining a vehicle load, either the initial definition dialog (as shown above) or the 
resulting attribute data can be viewed. This is done by right-clicking on the Attribute 
name in the Attributes Treeview and selecting either the Edit Definition or Edit 
Attribute menu item. Selecting the latter will show the following discrete point load 
data for the above vehicle selection. 
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This discrete point load can now be used to define the passage of the HB vehicle across 
the structure. 

Note. The front of the moving load is always the location with the maximum discrete 
load X co-ordinate. 

Composite Axle Definition of United Kingdom HB Vehicle using a 
Moving Load Vehicle Configuration 
The equivalent composite axle definition of the above HB vehicle can be achieved by 
defining a unit axle of the across carriageway configuration and defining the vehicle 
configuration separately. The following discrete point load defines the unit axle for the 
HB vehicle. 

 
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The IMDPlus moving load vehicle configuration dialog is used to create or modify 
vehicle configuration attributes for use in a moving load analysis. It is accessed from 
the Analyses > IMDPlus > Moving Load > Vehicle Configuration... menu or from 

the IMDPlus Toolbar. Ensure the  button is selected to choose a moving load 

analysis and then select the  button to launch the moving load vehicle configuration 
dialog. 

In a moving load vehicle configuration the position (relative to the origin / front of the 
vehicle) of each of the applied loads is defined along with the value of the moving load 
factor to be applied at each position. For the United Kingdom HB vehicle the axle 
positions and load factors shown in the following figure data should be entered into the 
dialog. A meaningful name should be entered into the Name field, for example, 
45Unit_HB_Axles. 
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Note. Care should be taken when defining axle positions (X co-ordinates) in discrete 
load configurations. The path length should be sufficiently longer than the structure to 
ensure that the load configuration correctly arrives onto and departs from the structure. 
In the above example, the path should start at least 4.8 m before the structure and finish 
4.8 m after the structure. 

Note. The front of the moving load vehicle is always the position with the maximum 
co-ordinate. The rear of the vehicle is always the position with the minimum co-
ordinate. 

Note. The positions and loads that define the vehicle configuration can be copied and 
pasted from a Microsoft Excel spreadsheet. This method is demonstrated in the 
IMDPlus Worked Example: Train Induced Vibration of a Bridge. 

Note. Once created vehicle configurations will appear in the Utilities Treeview, from 
where they can be modified or deleted from the model. To modify a vehicle 
configuration either double-click or right-click on the Attribute name in the Utilities 
Treeview and select the Edit Attribute... menu item. 

Note. Vehicle configurations can be easily transferred from one model to another 
using an attribute library file, accessed from the menu File > Import/Export model 
data... 

 

 

 

 

 
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Generation of the Moving Load Discrete Locations 
If a valid continuous path has been selected and a valid discrete load defined then the 
moving load generator can be used to create the static load cases at prescribed locations 
along the path. 

The IMDPlus moving load generation dialog is accessed from the Analyses > 
IMDPlus > Moving Load > Moving Load Generation... menu or from the IMDPlus 

Toolbar. Ensure the  button is selected to choose a moving load analysis and then 

select the  button to launch the moving load generation dialog. 

 

If a search area has been defined then this can be used to correctly assign the moving 
load if there are multiple planes to which the discrete load could be assigned. Project 
onto line or Project over area can be selected depending upon the geometry defining 
the search area. For single deck models, the default search area which encompasses the 
whole structure can be used. Parameters for the inclusion of the load can be accessed 
through the Advanced… button which provides the full application options available 
for discrete loads. These options consist of the inclusion of loads outside the search 
area and the load factor to be applied. 

Having defined the loading options, the load path options can be set based on the 
lines/arcs/splines selected to define the path. The incremental distance controls the 
separation of the discrete load locations used to define the passage of the load across 
the structure. This incremental distance should be positive and sufficiently small to 
capture the movement of the load.  
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Note. Due to the dynamic solution a sufficiently small distance should be used 
between the discrete locations defining the passage of the load to minimise 
oversampling for load locations between those defined. For static analyses, much larger 
distance increments can be used since the incremental movement does not need to be 
close to the time step of the analysis. 

Ideally, the distance increment used for the movement of the load along the path should 
obey the following equation: 

δDist ≤ 10 × Minimum Speed × δt 

to give a maximum oversample of 10. δt is the minimum of the Nyquist time step and 
any user specified time step (δtNyquist = 1/(2*fmax) where fmax is the maximum frequency 
included in the analysis). Larger distance increments can be used but warnings will be 
issued by IMDPlus since the accuracy of the dynamic solution decreases with 
increasing oversampling ratio. Oversampling ratio reduces with increasing speed and 
therefore it is possible that higher oversampling ratios can be used for lower speeds 
where the dynamic excitation is reduced. It is however up to the user to ensure that use 
of higher oversampling ratios for any speed does not adversely affect the solutions to 
the dynamic analysis. 

The moving load path forwards direction is defined by the order of selection of the 
lines, arcs or splines. The path starts at the first line that is connected to only one other 
selected line. If only a single line is selected, the forwards direction of the moving load 
path is defined by the line direction defined in Modeller (Line directions can be 
visualised through the Geometry layer in the Treeview). The direction that the moving 
load travels can be toggled between forwards and backwards relative to the original 
line selection for the generation of the discrete locations. The start and end of the path 
will be displayed along with the number of divisions / increments required for the full 
description. 

The number of load cases per analysis controls the number of load cases for each 
LUSAS analysis used to obtain the loading information. By default this is set to 100 
but can be increased up to 1000. Options are available to perform a datacheck analysis 
instead of a full static solution. The advantage of using this option is in both speed and 
the amount of disk space required for the LUSAS analyses. IMDPlus itself only 
requires the loading vector information from the datacheck analysis but if static 
solutions are also required for the passage of the moving load this option can be 
switched off. An option is also available not to run the analyses immediately. By 
default the LUSAS analyses will be carried out once the OK button has been clicked. If 
however the user wishes to run a large number of analyses resulting from the moving 
load definition overnight, this option can be switched off and a batch file generated so 
the analyses can be run separately. The original model, associated eigenvalue results 
and static load cases must be loaded prior to proceeding to the next stage of the moving 
load analysis. 

 
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This can be carried out by running the following two VBScript files which will have 
been generated in the directory \<LUSAS Installation Folder>\Projects\<Model 
Name>\Associated Model Data\<Model Name> 

IMDPlus_Model_Reload.vbs 

Reloads the model and eigenvalue results 

IMDPlus_LoadVector_Load.vbs 

Loads the static results on top of the model and eigenvalue 

Note. If for any reason the model and static load cases need to be loaded for the 
current moving load path and configuration in the future, these two VBScript files can 
be used. 

Modal Force Calculator 
The path and configuration of the moving load should have been defined using the 
moving load generation described previously. The discrete loads at distances along the 
path now need to be converted into equivalent modal forces for import into IMDPlus. 
This is carried out using the modal force calculator.  

The IMDPlus modal force calculator dialog is accessed from the Analyses > IMDPlus 
> Moving Load > Modal Force Calculator... menu or from the IMDPlus Toolbar. 

Ensure the  button is selected to choose a moving load analysis and then select the 

 button to launch the modal force calculator dialog. 

 

On entry, the eigenvalue and static results will be identified and placed into the dialog. 
Multiple eigenvalue results files are supported which allows the solution of structures 
with large numbers of eigenvalues over multiple analyses with frequency / eigenvalue 
ranges. 

 

 

 
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The moving load path options allow the user to change the direction of the load 
movement along the path but this option should not be used unless the load 
configuration is symmetrical. 

Note. Once the moving load generation and modal force calculation have been 
carried out in a moving load analysis, these two steps may be omitted from subsequent 
analyses, even if the analysis type is switched from moving load to moving mass but 
only if the moving load path, discrete load configuration and direction of the moving 
load do not change between analyses. If any of these are modified the moving load path 
and calculation of equivalent modal forces must be carried out again. 

Running the Moving Load Analysis 
An IMDPlus moving load analysis can only be performed if the following steps have 
already been undertaken: 

 The equivalent modal forces have been successfully calculated using the 
moving load generator and the modal force calculator 

 If a composite axle definition is being used at least one moving load vehicle 
configuration has been defined in the model 

  
The IMDPlus moving load analysis control dialog is shown in the following figure. On 
entering moving load analysis control for the first time the dialog will be filled with 
default information shown. 

 

The IMDPlus moving load analysis control dialog is accessed from the Analyses > 
IMDPlus > Moving Load > Moving Load Analysis... menu or from the IMDPlus 

 
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Toolbar. Ensure the  button is selected to choose a moving load analysis and then 

select the  button to launch the moving load analysis control dialog. 

Moving Load Input 
If a composite axle definition is being used in the analysis a vehicle configuration can 
be included by selecting the checkbox marked Vehicle configuration (Composite axle). 
This will enable the drop-down list that will contain all of the moving load vehicle 
configurations in the model. The required vehicle configuration can be selected for use 
in the IMDPlus analysis, as shown by the example in the following figure. 

 

Note. Although a vehicle configuration (composite axle definition) is designed for 
internal construction of complex loading configurations from a single axle, for example 
defining a complete trainset from a single unit axle, it can also be used to model the 
passage of more than one load configuration across the structure. Each load 
configuration is restricted to having the same plan layout but can have different 
magnitudes governed by the load factors contained in the vehicle configuration. 

Mode / Damping Control 
The modes to include in the analysis can be controlled either by the eigenmodes solved 
in the eigenvalue analysis or a subset defined in the mode control. The default option 
when first running an analysis is for all modes to be included in the analysis but 
individual modes can be included or excluded using the following dialog accessed via 
the Modify… button on the moving load analysis dialog. 

 
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This dialog also calculates the total participating mass for the included modes. If a 
significant proportion of participating mass is missing based on the selected modes of 
vibration a warning will be issued when proceeding with the analysis. Omission of 
modes of vibration with significant mass contributions that can be excited during the 
analysis will lead to unreliable solutions. Ideally, total mass participations in excess of 
90% should be used unless it is guaranteed that the modes of vibration associated with 
any missing mass are at frequencies that cannot be excited. 

The Default damping option allows the user to control the amount of damping used in 
the IMDPlus analysis. If Default damping is selected, all of the modes of vibration 
included in the analysis are forced to have the current default value. The default value 
is set, via the Modify… button on the moving load analysis control dialog. 

 

The Default damping option can only be turned off when viscous damping has been 
included in the eigenvalue analysis. If Default damping is deselected the viscous 
damping present in the eigenvalue analysis is used in the IMDPlus analysis. When 
viscous damping is included in the eigenvalue solution additional options for the 
inclusion of overdamped modes of vibration in the IMDPlus analysis also become 
available. These options are as follows: 

 Ignore overdamped modes 
Modes of vibration with a damping ratio of 100% or more are omitted from the 
IMDPlus solution. 
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 Limit overdamped modes to critically damped 
Modes of vibration with a damping ratio of 100% or more are limited to 
99.9999% to allow them to be included in the analysis. 

Solution Control 
The speeds and time stepping information are input via the solution control section. 
The input includes a range of speeds for the solution defined using a minimum speed, 
maximum speed and a speed increment. If only a minimum or maximum speed is 
specified then one speed, equal to the value entered, will be analysed for the moving 
load. A quiet time can be specified which allows for the inclusion of a user defined 
length of time after the passage of the load along the path. This enables decay of the 
structural vibration to be analysed. By default, IMDPlus determines the time step 
required for the analysis from the Nyquist time step. This is calculated from the 
maximum frequency included in the analysis. User control over the time step for the 
solution is available by disabling this feature. 

Advanced Moving Load Solution Options 

Advanced solution options can be set via the Modify... button on the moving load 
analysis control dialog. 

 

The options available in a moving load analysis are as follows. The Defaults button 
resets all of the options to the default values. 

 Time integration scheme for structure response 
The implicit time integration scheme used by IMDPlus to calculate the dynamic 
response of the structure. 

 Hilber Hughes Taylor (HHT) 
This is the default time integration scheme and is the same as the method 
used for an implicit transient dynamic analysis in LUSAS. 

 HHT factor α 
The integration constant α used in the HHT integration scheme. For an 
unconditionally stable, second order accurate scheme, α must lie between 
the limits -1/3 ≤ α ≤ 0.0. Values of α outside this range cannot be 
specified. The default value of α is 0.0, which reduces the method to the 
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Newmark method. Further integration constants β and γ are computed 
automatically by IMDPlus using the following equations: 

 ( ) ( )2
1 4      ,     1 2 2β = − α γ = − α  

 Duhamel’s Integral 
This is the time integration method used by IMDPlus in LUSAS 14.7 (and 
earlier versions of LUSAS) and is available as an alternative to the HHT 
integration scheme. 

 Interpolation method for modal forces 
The interpolation method used by IMDPlus to calculate the equivalent modal 
forces from the values obtained at the discrete path locations by the modal force 
calculator. 

 Cubic spline interpolation 
Equivalent modal forces are interpolated using a cubic spline interpolation 
technique. This is the default option. 

 Linear interpolation 
Equivalent modal forces are interpolated using a linear interpolation 
technique. 

Moving Mass Analysis 
The moving mass analysis option obtains the dynamic response of the structure to the 
passage of moving spring-mass systems along a user defined path. Both 2D and 3D 
structures can be analysed. The configuration of the spring-mass systems remains 
constant throughout the analysis but as they move across the structure, the dynamic 
response of the unsprung and sprung masses affects the forces acting on the underlying 
structure due to inertia effects. 

It is important to note the following working assumptions for the case of a moving 
mass analysis: 

 Only vertical motion of the spring-mass systems is considered 
 There is no loss of contact between the unsprung masses (wheels) of the spring–

mass systems and the structure at any time 
 The mass of the spring-mass systems have no effect on the natural frequencies 

of the structure 
 The accuracy of the moving mass solution reduces for light-weight structures or 

structures where the magnitude of the moving mass is similar to the magnitude 
of the structure mass. A literature search recommends that for most solutions of 
this type, the total mass of all the spring-mass systems that are actively 
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interacting with the structure at any given time should not exceed 10% of the 
total mass of the underlying structure. 

  
The following two steps are required to define the moving spring-mass systems that are 
to be used in the analysis: 

1. Define the spring-mass system property attribute(s) 
2. Define the moving mass vehicle configuration(s) using the positions of the 

axles/bogies that form a vehicle together with the spring-mass system property 
attribute that is to be used at each position 

Two further preliminary steps are required, in a similar manner to a moving load 
analysis, before a moving mass analysis can be undertaken. These generate equivalent 
modal forces by simulating the movement of a discrete unit load across the structure, 
using a number of distinct locations along a moving load path. The two steps are as 
follows: 

3. Generation of the moving load path across the structure 
A discrete load representing the unit load configuration for the axles/bogies of 
the vehicle that is to be moved across the structure must be defined. The moving 
load generator is then used to mimic the path of this unit load across the 
structure by automatically setting up a number of static load cases at prescribed 
locations along the path that the vehicle configuration is to follow. 

4. Calculation of equivalent modal forces for the moving load path 
The static load cases are used to calculate the modal forces equivalent to the 
applied unit loading for import into IMDPlus. The equivalent modal forces are 
used in IMDPlus together with the loading from the spring-mass systems of the 
vehicle to build up the complete loading configuration applied to the structure. 

Note. Steps 3 and 4 must be carried out before the first analysis but may be omitted 
from subsequent analyses, if and only if the moving load path, discrete unit load 
configuration and direction of the moving load do not change between analyses. If any 
of these are modified the moving load path and calculation of equivalent modal forces 
must be carried out again. 

 
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Spring-Mass System Properties 
A spring-mass system is represented by a single unsprung mass and up to two sprung 
masses, connected by springs and viscous dashpots, as shown in the following figure. 
A spring-mass system property attribute defines the masses, linear or nonlinear spring 
stiffnesses and viscous damping properties for a spring-mass system. Spring-mass 
system properties are assigned to different initial positions in a moving mass vehicle 
configuration in order to represent all of the axle/bogie locations of an entire vehicle or 
trainset. As these systems move across the structure, the motion of the unsprung and 
sprung masses affects the forces acting on the underlying structure due to inertia 
effects.  

 

Note. A vehicle or trainset may contain several axle/bogie positions with the same 
spring-mass system properties, that is, masses, spring stiffnesses and viscous damping 
constants. A spring–mass system property attribute can therefore be assigned to 
multiple axle/bogie positions when defining a vehicle configuration. 

 

Different spring behaviour can be modelled ranging from a simple linear elastic spring 
through to more complex nonlinear behaviour. Linear viscous dashpots can be 
optionally included for each of the sprung masses. Nonlinear spring behaviour allows 
for the inclusion of the following spring types. 

Piecewise linear springs 
Piecewise linear springs can be used to model bilinear springs or more general 
nonlinear spring behaviour.  

 

 
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Piecewise-linear spring: Nonlinear spring behaviour 

Piecewise linear springs can also be used to simulate stopper systems that limit the 
spring deflections through the inclusion of very high compressive spring stiffnesses 
after a given closure. 
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Piecewise-linear spring: Stopper system to limit deflections 

Polynomial Springs 
Polynomial springs can be used to represent nonlinear spring behaviour using the 
following function: 
  

 

N
a

a
a=1

F C dx= ∑
 

  
The total spring force, F, is expressed in terms of the total spring deflection, dx, where 
N is the order of the polynomial and Ca are the polynomial constants. This allows for 
the special cases of rubber springs and ‘C’ springs, as shown in the following figures, 
along with more general spring definitions. 
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Note. The polynomial function always passes through the origin of the spring force-
displacement curve. This ensures that the spring force is zero at zero spring 
displacement. 

 

 

Polynomial spring: Rubber Spring F = C1(x’s1-xu) + C3(x’s1-xu)3 

  

 

Polynomial spring: 'C' Spring F = C1(x’s1-xu) + C2(x’s1-xu)2 

Spring Mass System Properties Dialog 
The IMDPlus moving mass spring-mass system properties dialog is used to create or 
modify spring-mass system property attributes for use in a moving mass analysis. It is 
accessed from the Analyses > IMDPlus > Moving Mass > Spring Mass Properties... 

menu or from the IMDPlus Toolbar. Ensure the  button is selected to choose a 

moving mass analysis and then select the  button to launch the moving mass 
spring-mass system properties dialog. 
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Options for the spring-mass system are located in the upper left hand corner of the 
dialog. These define the number of sprung masses in the system and allow for the 
optional inclusion of damping and nonlinear spring behaviour. The number of sprung 
masses is controlled by selecting one of the following options from the drop-down list. 

 Unsprung mass only 
 Single sprung mass 
 Double sprung mass 

  
On the left hand side of the dialog a diagram of the chosen spring-mass system is 
displayed.  All property data is input on the right hand side of the dialog as follows: 

 Unsprung and sprung masses 
• Unsprung and sprung masses should be defined in the model mass units 
• If required, the unsprung mass can be set to 0.0 for a Single sprung mass or 

Double sprung mass system 
• If required, the 1st sprung mass can be set to 0.0 for a Double sprung mass 

system 
  
 Elastic spring stiffness 

• Elastic spring stiffnesses are only required if Nonlinear springs has not 
been selected 

• Elastic spring stiffnesses should be defined in the model stiffness units 
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 Viscosity coefficient 
• Viscosity coefficients are only required if Damping has been selected 
• Viscosity coefficients should be defined in the model force*time/length units 
• If required, the viscosity coefficients can be set to 0.0 

  
 Nonlinear springs 

If Nonlinear springs is selected the spring behaviour is defined using either 
polynomial constants or piecewise linear data. 

  
 Polynomial springs 

The spring force-displacement relationship is defined using a polynomial 
function 
• The polynomial constants Ca should be entered in the table where row 1 

defines the linear constant C1, row 2 defines the quadratic constant etc. 
• The polynomial function must have a positive value at a displacement of 

0.0 
• At least one of the polynomial constants must be non zero 
• IMDPlus requires the spring stiffness to always be a positive value. With 

higher order functions the gradient of the force-displacement relationship 
will generally reach a peak and become negative at a limiting 
compressive and/or tensile displacement. In these cases the IMDPlus 
analysis will terminate if the spring displacements ever reach these 
limiting values. 

  
 Piecewise linear springs 

The spring stiffness-deformation relationship is defined using a piecewise 
linear curve 
• Compressive and tensile data is input separately to ensure that the 

resulting force-displacement curves always pass through the origin 
  

 Stiffness 
• Spring stiffnesses should be defined in the model stiffness units 
• Spring stiffnesses must always be defined as a positive value 

  
 Deformation 

• Spring deformations should be defined in the model length units 
• The deformation of the first data point (row 1) of each piecewise 

linear curve must be set to 0.0 
• In compression all deformations must be negative and must be 

monotonically decreasing 
• In tension all deformations must be positive and must be 

monotonically increasing 
  
A meaningful name should be entered into the Name field. 
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Note. Once created spring-mass system properties will appear in the Utilities 
Treeview, from where they can be modified or deleted from the model. To modify a 
spring-mass system property either double-click or right-click on the Attribute name in 
the Utilities Treeview and select the Edit Attribute... menu item. 

Note. Spring-mass system properties can be easily transferred from one model to 
another using an attribute library file, accessed from the menu File > Import/Export 
model data... 

Moving Mass Vehicle Configuration 
The IMDPlus moving mass vehicle configuration dialog is used to create or modify 
vehicle configuration attributes for use in a moving mass analysis. It is accessed from 
the Analyses > IMDPlus > Moving Mass > Vehicle Configuration... menu or from 

the IMDPlus Toolbar. Ensure the  button is selected to choose a moving mass 

analysis and then select the  button to launch the moving mass vehicle 
configuration dialog. 

 

In an IMDPlus moving mass analysis a vehicle or trainset is represented by a number 
of spring-mass systems. A moving mass vehicle configuration includes the position 
(relative to the origin / front of the vehicle) of the axles/bogies that form the vehicle 
along with the spring-mass system attribute to be used at each position. Each row of the 
Spring-mass system column includes a drop-down list that contains all of the spring-
mass system property attributes in the model. The spring-mass system properties 
required at each position can be selected for use in the vehicle configuration. A spring–

 
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mass system property attribute can be used at multiple positions in a vehicle. An 
example of a moving mass vehicle configuration is shown in the figure. A meaningful 
name should be entered into the Name field. 

Note. Care should be taken with the definition of the spring-mass system positions. 
The path length should be sufficiently longer than the structure to ensure that the 
vehicle configuration correctly arrives onto and departs from the structure. 

Note. The front of the moving mass vehicle is always the position with the maximum 
co-ordinate. The rear of the vehicle is always the position with the minimum co-
ordinate. 

Note. The positions and spring-mass system identifiers that define the vehicle 
configuration can be copied and pasted from a Microsoft Excel spreadsheet. This 
method is demonstrated in the IMDPlus Worked Example: High Speed Train 
Modelling through Sprung Masses. 

Note. Once created vehicle configurations will appear in the Utilities Treeview, from 
where they can be modified or deleted from the model. To modify a vehicle 
configuration either double-click or right-click on the Attribute name in the Utilities 
Treeview and select the Edit Attribute... menu item. 

Note. Vehicle configurations can be easily transferred from one model to another 
using an attribute library file, accessed from the menu File > Import/Export model 
data... 

Moving Load Generation 
In a moving mass analysis the moving load generator is used to mimic the path of a 
unit load across a structure by automatically setting up a number of static load cases at 
prescribed locations along a single line/arc/spline, or a collection of lines/arcs/splines, 
which define a single continuous path. These load cases are subsequently used to 
calculate the unit modal forces equivalent to the applied unit loading for import into 
IMDPlus, where the unit modal forces are used together with the vertical loading from 
each of the spring-mass systems to obtain the total modal force applied to the structure. 

Note. In a moving mass analysis a discrete unit load must always be used in the 
moving load generator to ensure that the correct loads are applied to the structure 
during the IMDPlus analysis. The discrete unit load is used to calculate the unit modal 
forces that are applied to the structure as the discrete unit load moves along the moving 
load path. These unit modal forces are used in IMDPlus in conjunction with the vertical 
loading from the spring-mass systems of the vehicle configuration to calculate the total 
modal forces applied to the structure. 

Before entering the moving load generator, the lines/arcs/splines defining the path must 
be selected and a discrete load representing the unit load configuration for the 

 

 

 

 

 
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axles/bogies of the vehicle that is to be moved across the structure must have been 
defined. Examples of discrete unit loads are shown in the following figures. 

 

 

Generation of the Moving Load Discrete Locations 
The IMDPlus moving load generation dialog is accessed from the Analyses > 
IMDPlus > Moving Mass > Moving Load Generation... menu or from the IMDPlus 

Toolbar. Ensure the  button is selected to choose a moving mass analysis and then 

select the  button to launch the moving load generation dialog. 
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If a valid continuous path has been selected and a valid discrete unit load defined then 
the moving load generator can be used to create the static load cases at prescribed 
locations along the path. 

 

If a search area has been defined then this can be used to correctly assign the moving 
load if there are multiple planes to which the discrete unit load could be assigned. 
Project onto line or Project over area can be selected depending upon the geometry 
defining the search area. For single deck models, the default search area which 
encompasses the whole structure can be used. Parameters for the inclusion of the load 
can be accessed through the Advanced… button which provides the full application 
options available for discrete unit loads. These options consist of the inclusion of loads 
outside the search area and the load factor to be applied. The load factor for a moving 
mass analysis should always be set to 1.0. 

Note. In a moving mass analysis the load factor defined under the Advanced… 
options should always be set to 1.0 as the moving load generator needs to define the 
passage of a discrete unit load across the structure. Any factor other than 1.0 can cause 
the incorrect static and dynamic loads to be calculated during a moving mass analysis.  

Having defined the loading options, the load path options can be set based on the 
lines/arcs/splines selected to define the path. The incremental distance controls the 
separation of the discrete unit load locations used to define the passage of the unit load 
across the structure. This incremental distance should be positive and sufficiently small 
to capture the movement of the load.  

Note. Due to the dynamic solution a sufficiently small distance should be used 
between the discrete locations defining the passage of the unit load to minimise 
oversampling for load locations between those defined. 

 

 
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Ideally, the distance increment used for the movement of the unit load along the path 
should obey the following equation: 

δDist ≤ 10 × Minimum Speed × δt 

to give a maximum oversample of 10. δt is the minimum of the Nyquist time step and 
any user specified time step (δtNyquist = 1/(2*fmax) where fmax is the maximum frequency 
included in the analysis). Larger distance increments can be used but warnings will be 
issued by IMDPlus since the accuracy of the dynamic solution decreases with 
increasing oversampling ratio. Oversampling ratio reduces with increasing speed and 
therefore it is possible that higher oversampling ratios can be used for lower speeds 
where the dynamic excitation is reduced. It is however up to the user to ensure that use 
of higher oversampling ratios for any speed does not adversely affect the solutions to 
the dynamic analysis. 

The moving load path forwards direction is defined by the order of selection of the 
lines, arcs or splines. The path starts at the first line that is connected to only one other 
selected line. If only a single line is selected, the forwards direction of the moving load 
path is defined by the line direction defined in Modeller (Line directions can be 
visualised through the Geometry layer in the Treeview). The direction that the moving 
load travels can be toggled between forwards and backwards relative to the original 
line selection for the generation of the discrete locations. The start and end of the path 
will be displayed along with the number of divisions / increments required for the full 
description. 

The number of load cases per analysis controls the number of load cases for each 
LUSAS analysis used to obtain the loading information. By default this is set to 100 
but can be increased up to 1000. It is recommended that the option to perform a 
datacheck analysis instead of a full static solution is always selected as an IMDPlus 
moving mass analysis only requires the unit loading vector information from the 
datacheck analysis. 

Note. In a moving mass analysis a full static solution will only take into account the 
loading from the discrete unit load and will not include the total static loading from the 
spring-mass systems of the vehicle configuration. The results of the static analysis will 
therefore not correspond to the total vehicle loading that is going to be applied to the 
structure. 

An option is also available not to run the analyses immediately. By default the LUSAS 
analyses will be carried out once the OK button has been clicked. If however the user 
wishes to run a large number of analyses resulting from the moving load definition 
overnight, this option can be switched off and a batch file generated so the analyses can 
be run separately. The original model, associated eigenvalue results and static load 
cases must be loaded prior to proceeding to the next stage of the moving mass analysis. 
This can be carried out by running the following two VBScript files which will have 
been generated in the directory \<LUSAS Installation Folder>\Projects\<Model 
Name>\Associated Model Data\<Model Name> 

 
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IMDPlus_Model_Reload.vbs 

Reloads the model and eigenvalue results 

IMDPlus_LoadVector_Load.vbs 

Loads the static results on top of the model and eigenvalue 

Note. If for any reason the model and static load cases need to be loaded for the 
current moving load path and configuration in the future, these two VBScript files can 
be used. 

Modal Force Calculator 
The path and configuration of the moving unit load should have been defined using the 
moving load generation described previously. The discrete unit loads at distances along 
the path now need to be converted into equivalent modal forces for import into 
IMDPlus. This is carried out using the modal force calculator.  

The IMDPlus modal force calculator dialog is accessed from the Analyses > IMDPlus 
> Moving Mass > Modal Force Calculator... menu or from the IMDPlus Toolbar. 

Ensure the  button is selected to choose a moving mass analysis and then select the 

 button to launch the modal force calculator dialog. 

 

On entry, the eigenvalue and static results will be identified and placed into the dialog. 
Multiple eigenvalue results files are supported which allows the solution of structures 
with large numbers of eigenvalues over multiple analyses with frequency / eigenvalue 
ranges. 

The moving load path options allow the user to change the direction of the unit load 
movement along the path but this option should not be used unless the load 
configuration is symmetrical. 

Note. Once the moving load generation and modal force calculation have been 
carried out in a moving mass analysis, these two steps may be omitted from subsequent 

 

 
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analyses, even if the analysis type is switched from moving mass to moving load but 
only if the moving load path, discrete load configuration and direction of the moving 
load do not change between analyses. If any of these are modified the moving load path 
and calculation of equivalent modal forces must be carried out again. 

Running the Moving Mass Analysis 
An IMDPlus moving mass analysis can only be performed if the following steps have 
already been undertaken: 

 The equivalent modal forces have been successfully calculated using the 
moving load generator and the modal force calculator. A discrete load 
representing the unit load configuration for the axles/bogies of the vehicle that is 
to be moved across the structure must be used in the calculation of the modal 
forces to ensure that the correct loads are applied to the structure during the 
moving mass analysis. 

 At least one moving mass vehicle configuration has been defined in the model 
  
  
The IMDPlus moving mass analysis control dialog is accessed from the Analyses > 
IMDPlus > Moving Mass > Moving Mass Analysis... menu or from the IMDPlus 

Toolbar. Ensure the  button is selected to choose a moving mass analysis and then 

select the  button to launch the moving mass analysis control dialog. 

On entering moving mass analysis control for the first time the dialog will be filled 
with default information, as shown by the example in the following figure. 
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Moving Mass Input 
Vehicle Configuration 

The vehicle configuration drop-down list will contain all of the moving mass vehicle 
configurations in the model. The required vehicle configuration can be selected for use 
in the IMDPlus analysis. 

Path Surface Profile 

The surface roughness of the structure along the path followed by the moving mass 
vehicle can be optionally included via a perturbation of the vertical displacement of the 
structure. This is termed the path surface profile displacement and it is added to the 
displacements of the unsprung masses during the analysis. The path surface profile 
velocity and acceleration vertical components are calculated during the IMDPlus 
analysis and also applied to the unsprung masses for dynamic consistency. 

The path surface profile displacements are defined in a path surface profile file. Select 
the checkbox marked Path surface profile to include a path surface profile file in the 
IMDPlus moving mass analysis. This will enable the Browse... button so that the file 
can be selected, as shown by the example in the following figure. 



IMDPlus User Manual 

38 

 

The path surface profile file can contain either space, Comma Separated Variable 
(CSV) or TAB delimited data and must include a piecewise linear displacement vs. 
distance relationship that defines the surface irregularities along the path traversed by 
the moving mass vehicle. An example of a path surface profile is shown in the 
following figure. There should be a total of NPSP lines of data (NPSP defined below) 
in the file. All input data must be valid integer or real numbers and each line of the file 
should contain two data records as follows: 
  
  
For i=1,NPSP 

Disti   PSPi 

End loop over NPSP 
  
  
The path surface profile data is defined as follows: 

 NPSP 
• The number of data points in the path surface profile 
• There must be a minimum of 2 data points in order to define a valid profile 

  
 Disti 

The distance relative to the origin of the moving load path 
• Distances should be defined in the model length units 
• The distance of the first data point must be 0.0 
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• The distances must be defined so that they are monotonically increasing 
• Care should be taken to ensure that the last distance point in the file is equal 

to or greater than the length of the path. If this is not the case an additional 
point is automatically introduced during the IMDPlus analysis with a 
distance equal to the path length and a displacement of 0.0 

  
 PSPi 

The surface irregularity vertical displacement at the distance Disti 
• Displacements should be defined in the model length units 
• The displacement of the first data point must be 0.0 

  
An example of a path surface profile file is shown in the following figure. 

 
  
Mode / Damping Control 
The modes to include in the analysis can be controlled either by the eigenmodes solved 
in the eigenvalue analysis or a subset defined in the mode control. The default option 
when first running an analysis is for all modes to be included in the analysis but 
individual modes can be included or excluded using the following dialog accessed via 
the Modify… button on the moving mass analysis dialog. 
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This dialog also calculates the total participating mass for the included modes. If a 
significant proportion of participating mass is missing based on the selected modes of 
vibration a warning will be issued when proceeding with the analysis. Omission of 
modes of vibration with significant mass contributions that can be excited during the 
analysis will lead to unreliable solutions. Ideally, total mass participations in excess of 
90% should be used unless it is guaranteed that the modes of vibration associated with 
any missing mass are at frequencies that cannot be excited. 

The Default damping option allows the user to control the amount of damping used in 
the IMDPlus analysis. If Default damping is selected, all of the modes of vibration 
included in the analysis are forced to have the current default value. The default value 
is set, via the Modify… button on the moving mass analysis control dialog. 

 

The Default damping option can only be turned off when viscous damping has been 
included in the eigenvalue analysis. If Default damping is deselected the viscous 
damping present in the eigenvalue analysis is used in the IMDPlus analysis. When 
viscous damping is included in the eigenvalue solution additional options for the 
inclusion of overdamped modes of vibration in the IMDPlus analysis also become 
available. These options are as follows: 

 Ignore overdamped modes 
Modes of vibration with a damping ratio of 100% or more are omitted from the 
IMDPlus solution. 

 Limit overdamped modes to critically damped 
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Modes of vibration with a damping ratio of 100% or more are limited to 
99.9999% to allow them to be included in the analysis. 

Solution Control 
The speeds and time stepping information are input via the solution control section. 
The input includes a range of speeds for the solution defined using a minimum speed, 
maximum speed and a speed increment. If only a minimum or maximum speed is 
specified then one speed, equal to the value entered, will be analysed for the vehicle 
configuration selected. A quiet time can be specified which allows for the inclusion of 
a user defined length of time after the passage of the vehicle along the path. This 
enables decay of the structural vibration to be analysed. By default, IMDPlus 
determines the time step required for the analysis from the Nyquist time step. This is 
calculated from the maximum frequency included in the analysis. User control over the 
time step for the solution is available by disabling this feature. 

Advanced Moving Mass Solution Options 

Advanced solution options can be set via the Modify... button on the moving mass 
analysis control dialog. 

 

The options available in a moving mass analysis are as follows. The Defaults button 
resets all of the options to the default values. 

 Time integration scheme for structure response 
The implicit time integration scheme used by IMDPlus to calculate the dynamic 
response of the structure. 

 Hilber Hughes Taylor (HHT) 
This is the default time integration scheme and is the same as the method 
used for an implicit transient dynamic analysis in LUSAS. 

 HHT factor α 
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The integration constant α used in the HHT integration scheme. For an 
unconditionally stable, second order accurate scheme, α must lie between 
the limits -1/3 ≤ α ≤ 0.0. Values of α outside this range cannot be 
specified. The default value of α is 0.0, which reduces the method to the 
Newmark method. Further integration constants β and γ are computed 
automatically by IMDPlus using the following equations: 

 ( ) ( )2
1 4      ,     1 2 2β = − α γ = − α  

 Duhamel’s Integral 
This is the time integration method used by IMDPlus in LUSAS 14.7 (and 
earlier versions of LUSAS) and is available as an alternative to the HHT 
integration scheme.  

Note. When Duhamel’s Integral is selected the HHT factor α remains active and can 
still be modified.  In moving mass analysis the HHT scheme is always used to calculate 
the dynamic response of the spring-mass systems, irrespective of the time integration 
scheme selected. The value of α will therefore always have an effect on a moving mass 
analysis. 

 Interpolation method for modal forces 
The interpolation method used by IMDPlus to calculate the equivalent modal 
forces from the values obtained at the discrete path locations by the modal force 
calculator. 

 Cubic spline interpolation 
Equivalent modal forces are interpolated using a cubic spline interpolation 
technique. This is the default option. 

 Linear interpolation 
Equivalent modal forces are interpolated using a linear interpolation 
technique. 

 Control variables for spring-mass system solution 
The variables used to control the solution of the spring-mass systems as they 
move across the structure. 

 Maximum number of iterations 
The maximum number if iterations allowed for the spring-mass system and 
structural solution. The default is 100 iterations per solution attempt. If 
convergence problems occur this value may need to be increased. 

 
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 Maximum number of solution attempts 
The maximum number of solution attempts allowed during the spring-mass 
system and structural solution for each time step of the analysis. The default 
is 5. If convergence problems occur this value may need to be increased. 

 Convergence tolerance 
The convergence tolerance used for the spring-mass system and structural 
solution. The default is 0.1%. Increasing the convergence tolerance can 
reduce the time taken to perform an analysis but may produce inaccurate 
results. 

 Maximum constant for unsprung mass results update 
The maximum constant, CUSM, used in the calculation of the unsprung mass 
results. The default is 0.5 and the constant must lie between the limits 0.0 < 
CUSM ≤ 1.0. Larger values of CUSM can be used to reduce the time taken to 
perform an analysis but may result in convergence problems. If convergence 
problems do occur this value may need to be reduced. 

Path Surface Profile Options 

If a path surface profile has been included in the analysis advanced path surface profile 
options can be set via the Modify... button on the moving mass analysis control dialog. 

 

The path surface profile options are as follows. The Defaults button resets all of the 
options to the default values. 

 Interpolation method for displacements 
The interpolation method used by IMDPlus to calculate the path surface profile 
displacements from the discrete values defined in the path surface profile file. 

 Cubic spline interpolation 
Path surface profile displacements are interpolated using a cubic spline 
interpolation technique. 
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 Linear interpolation 
Path surface profile displacements are interpolated using a linear 
interpolation technique. This is the default option. 

 Start/end point method for velocities and accelerations 
IMDPlus calculates path surface profile velocities and accelerations from the 
displacement data defined in the path surface profile file. In order to calculate 
the complete velocity and acceleration profiles, displacement values beyond the 
extent of the user defined data are required. This option defines the method that 
is used to extrapolate the displacement profile at the start and end times of the 
analysis. 

 
 Use first and last values 

Displacement data is extrapolated using the path surface profile 
displacement values at the start and end of the analysis. This assumes that 
the displacement profile continues indefinitely with the first and last values. 
This is the default option and will be applicable in the majority of analyses. 

 Mirror values about vertical axis 
Displacement data is extrapolated by mirroring it about the vertical axis at 
the start and end of the analysis. For example, this option would be 
applicable where the path surface profile is defined using a cosine function 
which has peak values at the start and end of the analysis. 

 Mirror and reverse values about vertical axis 
Displacement data is extrapolated by mirroring it about the vertical axis at 
the start and end of the analysis and then multiplying the extrapolated data 
by -1. For example, this option would be valid where the path surface profile 
is defined using a sine function with zero displacement at the start and end of 
the analysis. 

Visualising the Results 
Results are extracted from IMDPlus through the output control dialog which is used for 
all of the seismic, moving load and moving mass analysis options. The IMDPlus output 
control dialog is accessed by selecting Next> from the seismic, moving load or moving 

mass analysis control dialogs or by selecting the  button from the IMDPlus 
Toolbar. 

Note. The  button will only be available for selection when an IMDPlus analysis 
has been performed and the results are still available on disk for graphing. 

For a seismic analysis the nodes or elements that are to be analysed are defined, 
together with the type of output that will be generated by IMDPlus. In addition, the 

 
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Earthquake to graph is selected using the drop-down list next to the Generate 
graphs in Modeller option. Examples of the appearance of the seismic output control 
dialog when processing an individual node or a selection of nodes are illustrated in the 
following figure.      

  

Individual Node Selected Nodes  

Seismic Analysis – Output Control Dialog 

For a moving load analysis the nodes or elements that are to be analysed are defined, 
together with the type of output that will be generated by IMDPlus. In addition, the 
moving load Speed to graph is selected via the list next to the Generate graphs in 
Modeller option. Examples of the appearance of the moving load output control dialog 
when processing an individual element or a selection of elements are illustrated in the 
following figure.      
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Individual Element Selected Elements 

Moving Load Analysis – Output Control Dialog 

For a moving mass analysis the nodes, elements or spring-mass systems that are to be 
analysed are defined, together with the type of output that will be generated by 
IMDPlus. In addition, the moving mass Speed to graph is selected via the list next to 
the Generate graphs in Modeller option. Examples of the appearance of the moving 
mass output control dialog when processing an individual node or an individual spring-
mass system are illustrated in the following figure.      

  

Individual Node Individual Spring-Mass System 

Moving Mass Analysis – Output Control Dialog 
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Node / Element Selection 
In this section of the output control dialog the nodes or elements that are to be analysed 
are defined, together with the result entity and component and the type of output that 
will be generated by IMDPlus. 

Processing Individual, Selected or All Nodes or Elements 
The Extent drop-down list includes the following options to determine whether 
individual or multiple, nodes or elements will be processed by IMDPlus. This enables 
results for a chosen set of nodes or elements to be obtained in a single IMDPlus 
analysis. 

 Individual 
Process a single node or element in IMDPlus. This option is always available 
for both Node and Element. With Individual the Node or Element lists are 
enabled and filled with the node numbers or valid IMDPlus element numbers 
selected in the model. Any of the node or element numbers listed can be chosen 
for the analysis or alternatively a valid node or element number can be manually 
specified by the user. 

 Selected 
Process the nodes or valid IMDPlus elements selected in the model. For Node 
this option will be available if nodes have been selected in the model. For 
Element the option will be available if valid IMDPlus elements have been 
selected in the model and they are all the same type. 

 All 
Process all of the nodes or valid IMDPlus elements in the model. For Node this 
option is always available. For Element the option will only be available if all 
of the elements in the model are the same type.  

Note. When analysing multiple elements, using Selected or All, only elements of the 
same type, that is, bar, thick beam, continuum, thick shell or thin shell elements, can be 
included in a set of IMDPlus elements. The element set can, however, contain elements 
with different numbers of Gauss points or nodes. 

Note. When Extent is set to Selected or All the Node, Element and Gauss 
Point/Node/End drop-down lists will not be available for selection. In addition the 
element Gauss Point/Node/End is automatically set to All as multiple elements are 
going to be processed in a single analysis. 

Note. Both Generate graphs in Modeller and Generate textfile output can be used 
when processing multiple node or element objects. With Generate textfile output a 
number of output file formats are supported by IMDPlus to allow import of results into 
graphing packages. These are discussed in the Output Control section presented later. 

 
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Entity and Component Output 
If Node output is selected, result entities supported are displacements, velocities, 
accelerations, and reactions plus, for moving load and moving mass analyses, dynamic 
amplification factors. The available components placed into the list will depend on the 
nodes chosen for the analysis. In addition to the standard single component output, 
options are also available to output all translational or rotational displacements, 
velocities, accelerations, reactions and dynamic amplification factors (when applicable) 
to the same graph. 

If Element output is selected, the result entities supported are governed by the element 
type chosen. For example, choosing a thick shell element allows selection of the Stress 
resultants (such as Nx, Mx and Sx), Stress (Top/Middle/Bottom) and Strain 
(Top/Middle/Bottom). Depending upon the element type either Gauss point, node or 
end results are available with the ability to select either a single location or All 
locations for an individual element. For a complete list of the output supported refer to 
the list of elements supported by IMDPlus. 

Results for Individual items, Sum of chosen items and Average of 
chosen items 
The Individual items, Sum of chosen items and Average of chosen items options 
determine the type of node or element output that will be generated by IMDPlus, see 
also Response time history and Peak response summary in the following section.  

 Individual items 
This option produces individual results for each of the chosen nodes or element 
Gauss points/nodes/ends. 

 Sum of chosen items 
This option adds together results from the chosen nodes or element Gauss 
points/nodes/ends to give summed node or element time histories from which 
peaks of the summed results are obtained. 

 Average of chosen items 
This option obtains results by first summing the time history results from the 
chosen nodes or element Gauss points/nodes/ends. A simple average of this 
summed result is obtained to give the node or element average time histories 
from which the peak average results are obtained. 

 
Sum of chosen items and Average of chosen items are only available for selection 
when Extent is set to Selected or All. 

Note. Any combination of the options Individual items, Sum of chosen items and 
Average of chosen items can be used in an IMDPlus analysis, although using the 
Individual items option when Extent is set to Selected or All (nodes or elements) may 
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produce a very large number of graphs, depending on the number of nodes or elements 
chosen for processing. 

Note. When processing reactions for a chosen set of nodes, Sum of chosen items and 
Average of chosen items only take into consideration nodes with supported freedoms. 

Note. When processing dynamic amplification factors only averaged results can be 
obtained for a chosen set of nodes as summed results are meaningless for this result 
entity. 

Spring-Mass System Selection (Moving Mass Only) 
This section of the output control dialog is only available in a moving mass analysis. It 
defines the spring-mass system, result and entity that will be processed by IMDPlus. 

Note. Only one of the Node, Element or Spring-mass system radio buttons can be 
selected at any given time. 

Processing Individual or All Spring-Mass Systems 
The Extent drop-down list includes the following options to determine which spring-
mass systems will be processed by IMDPlus. 

 Individual 
Process a single spring-mass system in IMDPlus. With Individual the System 
list is enabled and will contain, in sequential order, all of the system identifiers, 
together with the initial positions for each system and the spring-mass system 
property set used at each position, for the vehicle configuration selected in the 
IMDPlus moving mass analysis control dialog. Any of the spring-mass systems 
listed can be chosen for the analysis. 

 All 
Process all of the spring-mass systems for the vehicle configuration selected in 
the IMDPlus moving mass analysis control dialog. 

Note. When Extent is set to All the System drop-down list will not be available for 
selection. 

Note. Both Generate graphs in Modeller and Generate textfile output can be used 
when processing all of the spring-mass systems. With Generate textfile output a 
number of output file formats are supported by IMDPlus to allow import of results into 
graphing packages. These are discussed in the Output Control section presented later. 

Result and Entity Output 
The Result drop-down list contains the valid result types available for the system(s), 
selected using Extent and System. The result types available for selection depend on 
number of sprung masses in the system, that is, unsprung mass only, single sprung 

 
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mass or double sprung mass and whether a path surface profile has been included in the 
analysis. Results are generated as the spring-mass system moves across the structure 
and are available for the range of speeds defined in the IMDPlus moving mass analysis 
control dialog. 

 Unsprung mass 
The results for the unsprung mass of the spring-mass system(s). 

 Sprung mass 1 
The results for the 1st sprung mass of the spring-mass system(s). 

 Sprung mass 2 
The results for the 2nd sprung mass of the spring-mass system(s). 

 Contact point 
The structural results at the contact point(s) between the spring-mass system(s) 
and the structure. 

 Path surface profile 
The path surface profile followed by the system(s). These can be used to 
confirm that the user defined path surface profile has been interpreted correctly 
by IMDPlus. 

 
The Entity drop-down list contains the valid entities for the Result type selected. The 
entities available for selection are as follows; 

 Displacement 
The vertical component of displacement for the Result type of the spring-mass 
system(s). 

 Velocity 
The vertical component of velocity for the Result type of the spring-mass 
system(s). 

 Acceleration 
The vertical component of acceleration for the Result type of the spring-mass 
system(s). 

 Position 
The horizontal position of the unsprung mass of spring-mass system(s), relative 
to the initial position of the origin / front of the vehicle. This entity type is only 
available when Result is set to Unsprung mass 

 Force 
The vertical force applied to the structure by the spring-mass system. This entity 
type is only available when Result is set to Contact point 
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Output Control 
The output control section selects the types of results to visualise. Options are: 

 Response time history 
Response time history outputs node or element time history results for the 
selected Entity and Component or spring-mass system time history results for 
the selected Result and Entity. 

Results available include displacements, velocities, accelerations, dynamic 
amplification factors and reactions for nodes, forces/moments, stresses/stress 
resultants and strains/strain resultants for elements and vertical displacement, 
velocity, acceleration, position and force for spring-mass systems. 

For nodes or elements the type(s) of output generated depends on the options 
selected in the node / element selection section of the dialog as follows. 

 Individual items 
Individual time history results for all of the chosen nodes or elements are 
generated. 

 Sum of chosen items 
Summed time history results for the chosen set of nodes or elements are 
generated. 

 Average of chosen items 
Averaged time history results for the chosen set of nodes or elements are 
generated. 

When processing spring-mass systems individual time history results for the 
chosen system(s) are always generated. 

 Peak response summary 
Peak response summary outputs maximum, minimum and/or absolute peak 
results and times for the selected node / element Entity and Component or the 
selected spring-mass system Result and Entity. 

Results available include displacements, velocities, accelerations, dynamic 
amplification factors and reactions for nodes, forces/moments, stresses/stress 
resultants and strains/strain resultants for elements and vertical displacement, 
velocity, acceleration and force for spring-mass systems 

When processing nodes or elements an Envelope of the peak results can also be 
obtained for all components of the current result Entity. These highlight the 
individual nodes or element Gauss points/nodes/ends in the chosen set of nodes 
or elements where peak results occur for each of the earthquakes or speeds 
analysed. 
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For nodes or elements the type(s) of output generated depends on the options 
selected in the node / element selection section of the dialog as follows. 

 Individual output 
Individual peak results for all of the chosen nodes or elements are generated. 

 Sum of chosen items 
Peaks of the summed results for the chosen set of nodes or elements are 
generated. If Envelope has been selected an envelope of the individual peak 
results is also displayed in a Notepad application. 

 Average of chosen items 
Peaks of the averaged results for the chosen set of nodes or elements are 
generated. If Envelope has been selected an envelope of the individual peak 
results is also displayed in a Notepad application. 

When processing spring-mass systems individual peak summary results for the 
chosen system(s) are always generated. 

Note. The options Positive/Negative and Absolute are not available for selection in a 
seismic analysis. 

Note. Peak summaries are not available for spring-mass systems when Result is set 
to Path surface profile or Entity is set to Position 

Note. The option Envelope is only available for selection when either Sum of chosen 
items or Average of chosen items is selected. Envelope is not available when spring-
mass systems are being processed. 

 Secondary response spectra (SRS) 
Secondary response spectra (SRS) outputs secondary response spectra based on 
the acceleration response for nodes. SRS output is not available for 
displacements, velocities, dynamic amplification factors or reactions at nodes 
and is not a valid option for elements or spring-mass systems. SRS output can 
only be used when both Node and Individual items are selected. 

 Modal combination/factor history 
Modal combination/factor history outputs modal factors for the response of the 
structure at each time step of the analysis. The output takes the form of a 
VBScript file which can be imported into Modeller to define Modal 
Combinations of the modes of vibration. 

 Generate graphs in Modeller 
Generate graphs in Modeller presents the results from the IMDPlus analysis as 
graphs immediately after completion of the analysis. The earthquake or speed to 
graph is selected from the list of available records. 

 
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 Generate textfile output 
Generate textfile output saves the IMDPlus results to the \<LUSAS Installation 
Folder>\Projects\<Model Name>\Associated Model Data\<Model Name> 
directory in text format. These results can be archived or imported into 
additional graphing packages. 

  
Response Time History 
The time history results are computed by IMDPlus for the earthquake or speed 
specified in the output control dialogs shown in the preceding section. Examples of 
time history plots for an individual node and spring-mass system are shown in 
following figures. 

      

  

Seismic Analysis Time History Moving Load Analysis Time History  

  

Moving Mass Analysis Time Histories 

      
Peak Response Summary 
The peak response summaries are computed by IMDPlus for all of the earthquakes or 
speeds included in the analysis. Examples of peak output for an individual node and 
spring-mass system are shown in following figures. 

Note. Peak response summary graphs can only be generated in a moving load or 
moving mass analysis. For a seismic analysis the results are presented in tabular 
format. 

 
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Peak Response Text Output For 
Seismic Analysis 

Peak Response Plot For Moving 
Load Analysis 

  

Peak Response Plots For Moving Mass Analysis 

      
Secondary Response Spectra (SRS) 
Secondary Response Spectra (SRS) are computed for the selected nodes from the time 
history acceleration responses. The damping ratio range for the SRS calculations along 
with the frequency resolution are accessed via the Modify… button. In this dialog the 
minimum and maximum damping ratios can be entered along with the damping ratio 
increment. Control is also provided over the resolution of the SRS results computed.  

 

Examples of SRS plots are shown in the following figures: 
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SRS Plot For Seismic Analysis SRS Plot For Moving Load Analysis 
  
Modal Combination/Factor History 
Modal combinaton/factor history outputs modal factors for the response of the structure 
at each time step of the IMDPlus analysis. The modal combination history options are 
accessed via the Options… button. In this dialog the minimum mass participation 
factor percentage to include in the exported modal combinations can be defined. 

 

The output takes the form of a VBScript file which can be imported into Modeller to 
define modal combinations. These combinations can then be used to visualise the 
deformations and produce contour plots of entities other than velocities and 
accelerations, such as the examples shown in the following figures. 

Note. Importing all modal combinations could take significant time. For inspecting 
key times during the analysis the required combination information can be extracted 
from the original VBScript file and placed into a user defined VBScript file. 

 
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Vertical displacement plot for a time of 1.0s 

 

 
Vertical displacement plot for a time of 2.0s 

Generate Textfile Output 
If the option Generate textfile output is selected the results from the IMDPlus 
analysis will remain in the \<LUSAS Installation Folder>\Projects\<Model 
Name>\Associated Model Data\<Model Name> directory after completion of the 
analysis. This allows the IMDPlus results to be archived and exported to additional 
graphing packages. If graphs are being generated in Modeller, the output format for 
these text files is the default IMDPlus format, which has all of the QA information 
placed in the header of the file and the results written in space delimited format. If 
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however the option to Generate graphs in Modeller is switched off additional output 
formats become available via the Options… button which opens the following dialog. 

 

The formats supported are: 

 Fixed width space delimited format (IMDPlus default). Additional options are 
available to exclude the QA headers and set the QA information. 

 Comma Separated Variable (CSV) format. 
 TAB delimited format. 

For all text output formats, the extensions of the files indicate the results entity. The 
following list describes the output file extensions used by IMDPlus: 

*.dsp - Displacements/Rotations 

*.vel - Velocities/Rotational Velocities 

*.acc - Accelerations/Rotational Accelerations 

*.daf - Dynamic Amplification Factors 

*.rct - Force/Moment Reactions 

*.srs - Secondary Response Spectra 

*.fce - Forces/Forces and Moments 

*.str - Stresses/Stress Resultants 

*.stn - Strains/Strain Resultants 

*.pos - Positions of Spring-Mass Systems 

*.cfc - Vertical Forces for Spring-Mass Systems 

*.sum - Peak response summary 
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Elements Supported By IMDPlus 
Results for the following elements can be output and graphed directly from IMDPlus. 
Elements that are excluded from this list and are valid for 2D/3D eigenvalue analyses 
can still be used in an IMDPlus analysis but the results for these unsupported elements 
must be obtained through the modal combinations facility available in IMDPlus. All 
element output follows the default LUSAS Solver output directions (local or global) for 
the element types below. For further information please refer to the LUSAS Element 
Reference Manual. 

 Bar Elements (Gauss Point Results) 
BAR2 - 2D 2-noded Bar 
BRS2 - 3D 2-noded Bar 

  
 Beam Elements (End Results) 

BMI2 and BMI3 - 2D Thick Beams 
BMI2X - 2-noded 2D Thick Beams with Quadrilateral Cross-Section 
BMI3X - 3-noded 2D Thick Beams with Quadrilateral Cross-Section 
BEAM - 2D Engineering Thick Beam (for legacy models) 
BMS3 - 3D Engineering Thick Beam (for legacy models) 
BTS3 - 3D Thick Beam (for legacy models) 
BMI21 - 3D Thick Beam 
BMI22 - 3D Thick Beam 
BMI31 - 3D Thick Beam 
BMI33 - 3D Thick Beam 
BMX21 and BMX22 - 2-noded 3D Thick Beams with Quadrilateral Cross-
Section 
BMX31 and BMX33 - 3-noded 3D Thick Beams with Quadrilateral Cross-
Section 

  
 2D Continuum Elements (Gauss Point Results) 

TPM3, TPM6, QPM4, QPM8 - 2D Plane Stress 
QPM4M - 2D Plane Stress (Enhanced Strain) 
TPK6, QPK8 - 2D Plane Stress Crack Tip 
TPN3, TPN6, QPN4, QPN8 - 2D Plane Strain 
QPN4M - 2D Plane Strain (Enhanced Strain) 
TNK6, QNK8 - 2D Plane Strain Crack Tip 

  
 3D Continuum Elements (Gauss Point Results) 

TH4, TH10, PN6, PN12, PN15 – 3D Solid Continuum  
TH10K, PN15K, HX20K - 3D Solid Continuum Crack Tip  
HX8, HX16, HX20 - 3D Solid Continuum  
HX8M - 3D Solid (Enhanced Strain) 
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 Thin Shell Elements (Nodal Results) 

TS3, QSI4 - 3D Flat Thin Shell 
SHI4 - 3D Flat Thin Box Shell 

  
 Thick Shell Elements (Gauss Point Results) 

TTS3, TTS6, QTS4, QTS8 - 3D Thick Shell 
  
 Joint Elements (Gauss Point Results) 

JNT3 - 2D Joint Element for Bars, Plane Stress and Plane Strain 
JPH3 - 2D Joint Element for Engineering Beams 
JNT4 - 3D Joint Element for Bars and Solids 
JSH4 - 3D Joint Element for Engineering Beams and Shells 

Worked examples 
IMDPlus worked examples are available from the User Area of the LUSAS website. 
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